
Мастер-класс Репортаж на заказ. 
Коммерческая репортажная фотография 

  

Задачи на занятие 

 1. Основы коммерческой репортажной фотографии. 

2. Оборудование фотографа. Что необходимо иметь на съемке. 

3. Технические основы репортажной съемки 

4. Особенности работы репортажного фотографа на мероприятии. 

5. Ключевые моменты съемки. "Обязательные" кадры. 

6. Работы со вспышкой на репортаже. 

7. Выбор аксессуаров для внешней вспышки. Съемка с цветными гелями. 

8. Работа с несколькими вспышками на репортаже. Радисинхронизация, Nikon CLS и 
другие способы удаленного управления. 

9. Особенности обработки репортажных фотографий. 

10. Работа с цветом, обработка резкости, шумов, кадрирование. Обработка репортажных 
фотографий в Capture One Pro. 

11. Создание Actions в Adobe Photoshop. 

12. Основы успешного общения с клиентами разных “типов”: частные заказчики, 
корпоративные клиенты, event-агентства. 

 



 Основы коммерческой репортажной фотографии. 
  

Три главных отличия коммерческого репортажа от фотожурналистики: 

1) Задачи фотографа. Вы работаете по четкому брифу клиента. 

2) Качество. Абсолютно весь материал с вашей съемки должен быть качественным. Не 
допускается пересветов/недосветов, проблем с резкостью или чрезмерно шумных 
картинок. 

3) Количество. Стандартное количество фотографий после обработки - 300-700 кадров. 

  

Направления коммерческого репортажа: 

  

1) Бизнес-съемки  
 

 
  
Ключевые особенности: съемка портретов всех участников, кулуарное общение, 
разноплановые фотографии спикеров, красивые фотографии брендинга. 
  
 
 
 
 
 



2) Праздничные мероприятия 
  

 
  
Главная задача - передать ощущение праздника: радостные, улыбающиеся люди, 
позитивные эмоции. 
  
3) Тимбилдинги 

  
Ключевые особенности: веселые люди, спорт, интересные ракурсы, яркие кадры, 
"командность". 



Оборудование для съемки репортажа 

  

Камера + оптика + вспышка  

  

Оптика для репортажа 

Главная задача оптики - покрыть фокусные расстояния от 14 до 200мм 

Идеальный вариант: 14-24mm + 24-70mm + 70-200mm 

Хороший вариант для старта: 14mm фик (ручнофокусный) + Бюджетный зум или 35мм 
фикс + бюджетный телевик 
  

  

Экипировка 

Think Tank + Black Rapid 

  

Технические основы репортажной съемки 

  

Экспозиция 

На улице: Минимальное рабочее ISO + Приоритет диафрагмы (иногда приоритет 
выдержки для кадров с проводкой) 

В помещении: Максимальное рабочее ISO + Ручной режим 

  

Работа в ручном режиме экспозиции: 

Выдержка: 1/60-1/250 

Диафрагма: f/2.8 - f/8, "рабочая" диафрагма f/4.5 - f/5.6 

ISO: Максимальное рабочее ISO 

  

Как это работает 

Во время "пристрелки" к помещению ставим настройки (вспышка в режиме TTL в 
потолок): 
  



Выдержка 1/100 

Диафрагма 5.6 

ISO 800 

  

Если понимаете, что задний план слишком темный, то: 

Выдержка 1/80 

Диафрагма 5.6 

ISO 1600 

  

Если нужно еще высветить: 

Выдержка 1/60 

Диафрагма 4.5 

ISO 1600 

  

Фокусировка - AF-C + Single-Point AF 

  

Цвет 

  

Как управлять цветом? 

1) Снимать всегда в RAW  

2) Баланс белого (90% случаев Авто ББ, в 10%  - ручной режим, когда условия съемки не 
меняются) 

3) Управление вспышкой + обработка 

  

Особенности работы репортажного фотографа на мероприятии. 

  
1) На съемку всегда приезжать за 30 минут 
  
2) До начала съемки обсудить кого, когда и как снимать 
  



  

Ключевые моменты съемки. "Обязательные" кадры. 

  
1) Брендинг 
2) Сбор гостей 
3) Портреты участников 
4) Действо  
5) Групповые снимки 
6) Фотографии аниматоров 
7) Еда 
8) Детали 
9) Интерьеры 
10) Общие планы 
13) Общение гостей 
14) Главные моменты мероприятия 
15) Артисты 
16) Танцы 
17) Дети 
  
  

Работы со вспышкой на репортаже. 

  

Выставляем: 

диафрагма 

ISO 

выдержка  

затем 

настраиваем вспышку 

  

Ключевой момент - естественный (на площадке) и искуственный (от вспышки) свет. 

  

Чем длинне выдержка 

Чем открытее диафрагма 

Чем выше ISO 

Тем больше в кадре естественного света. 

  



То есть ваша главная задача - научиться гармонично сочетать искуственный свет от 
вспышки и естественный свет на площадке.  

Свет на площадке регулируется настройками экспозиции, свет от вспышки - 
корректировкой мощности вспышки. 

  

Режимы работы вспышки 

Чаще используем TTL, иногда Manual (во время съемки в неизменных условиях). 

  

Основы работы с накамерной вспышкой 

В помещении:  

Отражать свет + TTL или M + Коррекция мощности 

  

На улице: 

Пыхать «в лоб» + Чаще M, иногда TTL + Коррекция мощности 

  

Цветные фильтры: 

  

Используются для баланса цветовых температур, когда нужно уравновесить цветовую 
температуру вспышки и освещение в помещении. 

Типичная ситуация - в помещении желтый свет, свет от вспышки - холодный. Тогда на 
вспышку надеваем оранжевый фильтр и свет от вспышки становится теплее. Таким 



образом освещение на переднем плане (от вспышки) и на заднем (освещение в 
помещении) будет уравновешано. 

Так же фильтры можно использовать для художественных целей, когда нужно цветом 
подстветить определенные объекты в кадре. 

Работа с несколькими вспышками: 

Способы синхронизации: 

Светоловушка - самый простой режим, когда вспышка срабатывает от любой другой 
вспышки. Не требует дополнительно оборудования, но будет пыхать каждый раз когда 
кто-либо рядом использует вспышку. 

Nikon CLS (или ее аналог у Canon) - система, при которой можно управлять вспышками в 
том числе в режиме TTL по инфрокрасному сигналу. Очень удобный и простой способ 
синхронизации. Проблема - плохо работает на больших расстояниях. 

Радиосинхронизация - универсальный способ, который работает на больших дистанциях. 
Минус - системы радиосинхронизации, поддерживающие TTL, стоят довольно дорого.  

Аксессуары для вспышки 

Самый универсальный - обычный отражатель. Он дает отличный заполняющий свет при 
съемке "в потолок". 

  

  

  



При съемке, когда вспышку держите в руке - отлично подходит софт-бокс (для портретов 
на мероприятии). 

  

Стробофрейм 

Позволяет очень быстро изменить положении вспышки таким образом, чтобы и 
горизонтальные и вертикальные кадры были одинаково качественно освещены. 

   

Особенности обработки репортажных фотографий 
  

Ключевые моменты обработки в Capture One 

  

1) Правильно настроенный интерфейс. 

Все лишнее — убираем, ключевые инструменты группируем. 

Все главные инструменты обработки репортажа должны быть всегда под рукой: 
Обработка экспозиции, Shadow/Highlights, Баланс Белого, Clarity, Levels, Curves. 

При этом в других вкладках у вас должны быть собраны остальные важные инструменты, 
которые используются реже — для работы со слоями, исправления оптических дефектов, 
сложной обработки цвета. 

2) Постоянно использовать хоткеи (горячие клавиши). 

Движение мышки желательно свести к минимуму, а все возможные операции делать 
быстрыми клавишами на клавиатуре. 

Сэкономленные доли секунды на каждом действии в итоге складывают в десятки часов 
освободившегося времени.  

3) Копировать настройки от одного файла к группе фотографий. 

Обработка каждого кадра с нуля — бессмысленный и долгий процесс. Если вы хотите 
снимать 4-5 мероприятий в неделю и не проводить все остальное время за обработкой — 
учитесь работать с группами файлов. 

Принцип очень простой — берем серию кадров, снятых в похожих условиях, 
обрабатываем один кадр, а затем копируем все ключевые настройки (Баланс Белого, 
Экспозиция, Шэдоу-Хайлайтс, Клэрити) на остальные фотографии из этой группы. 

После этого вам остается только быстро пробежаться по этим кадрам, внося 
индивидуальные правки (кроп, горизонт, слои). 

  



 Кастомизация интерфейса 

  

• Интерфейс Capture One можно полностью настроить под себя: любой инструмент 
или вкладку с инструментами можно перенести, а элементы интерфейса 
расположить так, как вам будет удобно. 

 

Например, чтобы перенести инструменты обработки в правую часть экрана нажмите View 
—> Place Tools Right , а для того, 

чтобы расположить браузер картинок слева выберите View —> Place Browser Left. 

• Вкладки с инструментами можно перемещать, зажав Command. 

• Сохранить получившийся интерфейс можно в Window —> Workspace —> Save 
Workspace. 

  
Для обработки репортажа оптимальный вариант настройки интерфейса - собрать в две 
вкладки все главные инструменты.  
  
В одну вкладку поместить инструменты для первичной, основной обработки, во вторую - 
для детальной коррекции изображения. 

   

Увеличение резкости и борьба с дефектами изображений. 

Для обычных репортажных-фотографий (без расчета на печать больших форматов) 
подойдут такие значения увеличения резкости: 

Amount: 220-270 

Radius: 0,9-1 

Threshold: 1 



Удалить матричную грязь в Capture One можно с помощью инструмента Spot, а все 
оптические дефекты изображения устраняются с помощью инструмента Lens Correction. 

  

Пакетная обработка фотографий. 

  

  

С помощью инструмента Adjustments Clipboard вы можете копировать настройки 
обработки (все или только выбранные) на любые другие фотографии. Так же настройки 
можно сохранить в стиль или пресет и использовать их в будущем. 

  

Работа со слоями и масками выделения. 

  

Local Adjustments – один из самых сильных инструментов обработки Capture One, 
который позволяет выделив участок кадра, затемнить или осветлить его, обесцветить или 
детально поработать с цветовыми оттенками именно этой области фотографии. 



 

C помощью Local Adjustments мы можем работать индивидуально с определенными 
участками кадра. 

  

Создание Actions в Adobe Photoshop 

  

Наша задача — сделать action, который будет сам ресайзить фотографии до нужного 
размера, увеличивать резкость и сохранять фотографии в нужном нам качестве. 

Написание подобного экшена невозможно без одной очень удобной функции в Photoshop 
— Fit Image. Fit Image позволяет подогнать изображение под заданный размер вне 
зависимости горизонтальный это или вертикальный кадр.  

Создаем новый экшен и начинаем запись: 

1. Открываем любую фотографию в Photoshop и над ней будем проводить манипуляции, 
которые запишутся в action. 

2. Теперь конвертируем в sRGB — Edit=>Convert To Profile, на тот случай, если вы 
работаете с Adobe RGB или ProPhoto RGB. Дело в том, что sRGB — это стандартный 
цветовой профиль, который правильно понимают все интернет-браузеры. Adobe RGB и 
ProRGB не поддерживаются большинством распространенных браузеров. Если вы 
работаете только с sRGB, это действие можно не вписывать в экшн. 

3. Применяем Fit Image со значением 10000 px. На мой взгляд, 1000 px — это 
оптимальный размер превью фотографии. Хотя вы можете выставить там любое другое 
значение, конечно. 

4. Займемся увеличением резкости. Открываем Filter=>Sharpen=>Smart Sharpen. В 
зависимости от ваших личных предпочтений устанавливаем настройки резкости. Я, как 
правило, делаю такие настройки: 

5. Наше превью готово, осталось только сохранить фотографию – File=>Save As. 

В этом окне важно обратить внимание на строку Embed Color Profile. Поставив галочку 
рядом с этим пунктом, вы прикрепляете к файлу ICC профиль. 

 Затем откроется окно настроек – для публикации в интернете качества 9-10 будет более 
чем достаточно. 

6. Закрываем фотографию — это действие тоже должно быть записано в экшене. 



Вот и все, нажимаем Stop и наш action готов. 

  

Применить экшен на группу фотографий можно в разделе File --> Automate --> Batch 

   

Общение с клиентом 
  
Три типа клиентов: 
  
1) Корпоративные - самый лучший клиент для регулярных высокооплачиваемых заказов. 
Важно четко понять, какие именно кадры нужны компании (обычно приоритет брендингу, 
люди в кадре определенного социального типажа и тп) 
  
2) Частные - важно понять, какой стиль съемки нравится частному клиенту и выдержать 
съемку именно в таком стиле 
  
3) Event-агентства - поставляют большое количество заказов, но демпингуют по цене 
  

Что нужно обсудить до съемки? 

- Гонорар 
- Детали съемки, которые могут потребовать дополнительного оборудования 
- Желателен четкий бриф (для крупных эвентов) 
- Количество людей на мероприятии (максимум для качественной съемки одного 
фотографа - 200 человек) 
  

Подача фотографий клиенту 

Обязательно с нормальными названиями (001, 002, 003), если отдаете диск - с обложкой 
или картинкой на диске. 

Все фотографии должны быть в двух вариантах - полноразмерные кадры для печати и 
небольшие превью для интернета 

  

Поиск клиентов 

Необходимо место для публикации порфтолио - сайт или блог. 

Поиск клиентов в интернете 

- Контекстная реклама (важно понять как правильно с ней работать) 

- Сайты каталоги и фриланс-сайты (для бюджетных клиентов) 

- Соц. сети и форумы (можно найти хороших частных заказчиков) 
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